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Disclaimer

The information contained in this document is for general informational purposes only and does
not constitute an offer, solicitation, invitation or recommendation to buy or sell any futures
contracts or other products or to provide any investment advice or service of any kind. This
document is not directed at, and is not intended for distribution to or use by, any person or entity in
any jurisdiction or country where such distribution or use would be contrary to law or regulation or
which would subject Hong Kong Exchanges and Clearing Limited (“HKEX”), Hong Kong Futures
Exchange Limited (“HKFE”) (together, the “Entities”, each an “Entity”), or any of their affiliates, or
any of the companies that they operate, to any registration requirement within such jurisdiction or
country.

No section or clause in this document may be regarded as creating any obligation on the part of
any of the Entities. Rights and obligations with regard to the trading, clearing and settlement of any
futures contracts effected on HKFE shall depend solely on the applicable rules of HKFE and the
relevant clearing house, as well as the applicable laws, rules and regulations of Hong Kong.

Although the information contained in this document is obtained or compiled from sources
believed to be reliable, neither of the Entities guarantees the accuracy, validity, timeliness or
completeness of the information or data for any particular purpose, and the Entities and the
companies that they operate shall not accept any responsibility for, or be liable for, errors,
omissions or other inaccuracies in the information or for the consequences thereof. The
information set out in this document is provided on an “as is” and “as available” basis and may be
amended or changed. It is not a substitute for professional advice which takes account of your
specific circumstances and nothing in this document constitutes legal advice. Neither of the
Entities shall be responsible or liable for any loss or damage, directly or indirectly, arising from the
use of or reliance upon any information provided in this document.

Additional disclaimer for CES China 120 Index Futures
CES China 120 Index (“CES 120 Index”) are calculated and / or disseminated by China Securities
Index Company Limited (“CSIC”) on behalf of China Exchanges Services Company Limited
(“CESC”). Neither CESC nor CSIC guarantee (expressly or impliedly) the accuracy, completeness,
timeliness or fitness for a particular purpose of the CESC Index and/or the information contained
therein; nor do they accept any liability for any damages, loss, costs or expenses suffered by any
person arising from the use of the CESC Index and/or the information contained therein.
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As at 29 December 2023

Equity Indices Monthly Performance in
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December 2023

Sector Indices vs HSI / HSCEI CES120 vs China Theme Indices

Equity Index Futures Access Codes

-1.5%

-1.2%

0.03%

3.2%

HSCEI

MSCI China A 50 Index

HSI

HS Mainland
Banks Index

% Change

Index Name

-2.8%

-2.1%

-1.9%

CES120 Index

FTSE A50 Index

CSI 300 Index

% Change

Index Name

Vendor HS Mainland Banks CES 120 HSI HSCEI

Bloomberg BMWA CESA HIA HCA

Refinitiv 0#HMBI: 0#HCHH: 0#HSI: 0#HCEI:

WIND MBIF CHHF HSIF HHIF

ET Net MBI CHH HSI HHI

Data Source: Bloomberg

Information for reference only



Hang Seng Index (HSI) Futures & Options

Equity Index Futures & Options
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Data Source: HKEX

* OI compared to previous year-end

Information for reference only

HSI Futures (YoY) HSI Options (YoY)

HSI Futures (MoM) HSI Options (MoM)

As at 29 December 2023
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HSI Products 

(2023 vs 2022)
ADV OI*

HSI Futures 143,434 (-6%) 149,607 (+31%)

Mini-HSI Futures 97,150 (-10%) 21,140 (+79%)

HSI Options 24,234 (-6%) 129,380 (+19%)

Mini-HSI Options 13,418 (+8%) 19,976 (+48%)

HSI Futures 

Options
4,096 (+57%) 59,229 (+12%)

HSI Volatility 

Index Futures
0 (-) 0 (-)

HSI Dividend 

Point Index 

Futures

107 (+269%) 9,521 (+2866%)



HSI Futures & Options

Equity Index Futures & Options

5

Data Source: HKEX, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference only

As at 29 December 2023

Hang Seng Index

 Includes the largest and most 

 liquid stocks listed in Hong Kong

 Index Level  17,047.39 (As at 29 Dec 2023)

 Index Volatility (30-Day Historical)  26.6

 Index Avg. Day High-Low Range  226.58 (Dec 2023)

 HSCEI Correlation (2023)  0.986

 Contract Multiplier  HK$50

 Notional Value (1 Contract)  HK$0.85Mn (As at 29 Dec 2023)

Transaction Cost*

Stamp Duty  N/A

Trading Fee  HK$10 / contract

SFC Levy  HK$0.54 / contract

Commission Rate  Negotiable

Margin as of 28 Dec 2023  HK$59,150

Hang Seng Index Futures

 Index Description

HSI & Top 5 Constituents

Distribution of HSI Index Options OI in Month-end
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Hang Seng China Enterprises Index (HSCEI) Futures & Options

Equity Index Futures & Options
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Data Source: HKEX

* OI compared to previous year-end

Information for reference only

As at 29 December 2023

HSCEI Futures (YoY) HSCEI Options (YoY)

HSCEI Futures (MoM) HSCEI Options (MoM)
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(No. of Contracts)

HSCEI Products 

(2023 vs 2022)
ADV OI*

HSCEI Futures 193,940 (+6%) 602,555 (-1%)

Mini HSCEI 

Futures
10,535 (-23%) 5,673 (+12%)

HSCEI Options 48,553 (+8%) 1,329,922 (+16%)

Mini HSCEI 

Options
3,779 (+8%) 28,513 (+2%)

HSCEI Futures 

Options
35,536 (+83%) 1,097,453 (+49%)

HSCEI Dividend 

Point Index 

Futures

1,298 (-5%) 85,256 (+48%)



HSCEI Futures & Options

Equity Index Futures & Options
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Data Source: HKEX, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference only

As at 29 December 2023

HSCEI & Top 5 Constituents
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HSCEI

Comprises the largest and 

most liquid H shares

 Index Level  5,768.50 (As at 29 Dec 2023)

 Index Volatility (30-Day Historical)  30.1

 Index Avg. Day High-Low Range  88.62 (Dec 2023)

 Correlation with HSI, CES120 (2023)  0.986,0.933

 Correlation with CSI300, FTSE A50

 (2023)
 0.701,0.704

 Contract Multiplier HK$50

 Notional Value (1 Contract)  HK$0.29Mn (As at 29 Dec 2023)

Transaction Cost*

Stamp Duty  N/A

Trading Fee  HK$3.5 / contract

SFC Levy  HK$0.54 / contract

Commission Rate  Negotiable

Margin as of 28 Dec 2023  HK$24,250

HSCEI Futures

 Index Description

HSI vs HSCEI 

Distribution of HSCEI Index Options OI in Month-end



Weekly HSI & HSCEI Options Performance
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Data Source: HKEX

* All calculations are in HKD and exclude commission fees

Information for reference only

As at 29 December 2023

An investment tool to manage short term event risk

Weekly HSI & HSCEI Options Volume

Contract Multiplier  HK$50

Liquidity Providers  Eclipse, I-Access, IMC, Maven, Optiver

Transaction Cost*

Stamp Duty  N/A

Trading Fee  HK$10 / contract

SFC Levy  HK$0.54 / contract

Commission Rate  Negotiable

Contract Multiplier  HK$50

Liquidity Providers  Eclipse, I-Access, IMC, Maven, Optiver

Transaction Cost*

Stamp Duty  N/A

Trading Fee  HK$3.5 / contract

SFC Levy  HK$0.54 / contract

Commission Rate  Negotiable

Weekly HSI Options

Weekly HSCEI Options
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Single Stock Futures & Options

Equity Futures & Options
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Data Source: HKEX

* OI compared to previous year-end

Information for reference only

As at 29 December 2023

Stock Options (YoY)Stock Futures (YoY)

No. of Single Stock Derivatives

Single Stock Futures 98

Single Stock Options 126

Stock Futures

• Products

➢ 3 A-shares ETFs futures contracts

➢ Total 98 stock futures contracts

Latest and Future Developments

Stock Options

• Products

➢ 3 A-shares ETFs options contracts

➢ Total 126 stock options contracts

• Market Makers (MMs)

➢ 3 types of market makers (PMM/ CQMM/ 

QRMM)

➢ CQMM to provide 50 series continuous 

quotations

Stock Futures (MoM) Stock Options (MoM)

0

5,000

10,000

15,000

20,000

25,000

30,000

35,000

40,000

0

2,000

4,000

6,000

8,000

10,000

12,000 ADV (L-Axis)

Open Interest (R-Axis)

(No. of Contracts) (No. of Contracts)

Open InterestAv erage Daily  Volume

0

2,000,000

4,000,000

6,000,000

8,000,000

10,000,000

12,000,000

0

200,000

400,000

600,000

800,000 ADV (L-Axis)

Open Interest (R-Axis)

(No. of Contracts) (No. of Contracts)

Av erage Daily  Volume Open Interest

0

10,000

20,000

30,000

40,000

0

2,000

4,000

6,000

8,000

10,000

Ja
n

F
eb

M
a
r

A
p
r

M
a
y

Ju
n

Ju
l

A
u
g

S
e
p

O
c
t

N
o
v

D
e
c

2023

ADV (L-Axis)

Open Interest (R-Axis)

(No. of Contracts) (No. of Contracts)

Open InterestAv erage Daily Volume

0

4,000,000

8,000,000

12,000,000

0

200,000

400,000

600,000

800,000

Ja
n

F
eb

M
a
r

A
p
r

M
a
y

Ju
n

Ju
l

A
u
g

S
e
p

O
c
t

N
o
v

D
e
c

2023

ADV (L-Axis)

Open Interest (R-Axis)

(No. of Contracts)

Open Interest
(No. of Contracts)

Av erage Daily  Volume

Single Stock Derivatives ADV (2023 vs 2022) ADV OI*

Stock Futures 6,994 (-11%) 32,763 (-4%)

Stock Options 651,154 (+11%) 10,945,598 (+42%)



Hang Seng TECH Index Futures, Options and Futures Options Performance
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Data Source: HKEX

* Exclude commission fees

Information for reference only

As at 29 December 2023

Volume and Open Interest continue to growth
Providing investors with a tool to manage their risk exposure 

to Hong Kong-listed technology companies

Tracks the largest technology companies

listed in Hong Kong

Hang Seng TECH Index Futures & Options & Futures Options

Contract Multiplier HK$50 per index point

Notional Value (1 Contract) HK$188K (As at 29 December 2023)

No. of Liquidity Providers  N/A

Transaction Cost*

Stamp Duty  N/A

Trading Fee  HK$5.00 / contract

SFC Levy  HK$0.54 / contract

Hang Seng TECH Index

Index Description
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MSCI China A 50 Connect Index Futures Performance
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Data Source: HKEX

* All calculations are in USD and exclude commission fees

Information for reference only

As at 29 December 2023

Risk management tool for diversified China portfoliosSector-balanced exposure to China’s A-share market

 MSCI China A 50 Connect Index

 Balanced representation from 11 sectors

 of top 50 China A shares

 Index Level  1,816.83 (As at 29 December 2023)

 Index Volatility (30-Day Historical)  14.8

 Index Avg. Day High-Low Range  16.80 (December 2023)

 CSI300 Correlation (2023)  0.964

 FTSE A50 Correlation (2023)  0.974

 Contract Multiplier  US$25

 Notional Value (1 Contract)  US$0.05Mn (As at 29 December 2023)

 Average Quote Size  US$0.23Mn (5 Contracts)

Transaction Cost*

Stamp Duty  N/A

Trading Fee  US$0.5 / contract

SFC Levy  US$0.07 / contract

Margin as of 28 Dec 2023  US$2,600

 MSCI China A 50 Connect Index Futures

 Index Description

Average Daily Volume (as of December 2023)

Open Interest (as of 29 December 2023)
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MSCI Asia and Emerging Market Index Futures Performance
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Data Source: HKEX

* Exclude commission fees

Information for reference only

As at 29 December 2023

Volume and Open Interest continue to growth
HKEX with the broadest suite of MSCI derivatives products 

based in the Asian time-zone
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ADV

representation 38 DM and EM countries and

regional indices

MSCI Asia and Emerging Market Index Futures

Contract Multiplier Average US$40

Notional Value (1 Contract) Average US$47K (As at 29 December 2023)

No. of Liquidity Providers 12

Transaction Cost*

Stamp Duty  N/A

Trading Fee  US$0.6-US$1.0 / contract

SFC Levy  US$0.07 / contract

MSCI Asia and Emerging Market Index

Index Description

Open Interest (As of 29 December 2023)

Average Daily Volume (As of December 2023)



MSCI AC Asia ex Japan NTR Index (AxJ) Futures Performance
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Data Source: HKEX

* All calculations are in USD and exclude commission fees

Information for reference only

As at 29 December 2023

MSCI AxJ Combines Developed and Emerging Markets (Rebased  to 100)

MSCI AxJ is a well-established benchmark representing Asia 

regional (excluding Japan) equity market performance
Futures contracts have relatively lower transaction costs
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 MSCI AxJ

representation 2 DM countries (excl. Japan)

and 9 EM countries in Asia

 Index Level  516.62 (As at 29 December 2023)

 Index Volatility (30-Day Historical)  11.6

 Index Avg. Day High-Low Range  3.96 (December 2023)

 HSI Correlation (2023)  0.902

 HSCEI Correlation (2023)  0.889

 Contract Multiplier  US$100

 Notional Value (1 Contract)  US$52K (As at 29 December 2023)

 Avg. Quote Size  US$0.26Mn (5 Contracts)

 Avg. Bid-Ask Trading Spread  1.1 index points (December 2023)

 Liquidity Providers Flow  and 11 banks

Stamp Duty  N/A

Trading Fee  US$0.5 / contract

SFC Levy  US$0.07 / contract

Margin as of 28 Dec 2023  US$1,950

 Transaction Cost*

 MSCI AxJ Futures

 Index Description
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Hang Seng Mainland Banks Index Futures Performance
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Data Source: HKEX, HSIL, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference only

As at 29 December 2023

Index & Constituents 3-Month Performance (Rebased to 100)

HSMBI Futures can be used for hedgingFutures contracts have relatively lower transaction costs

 Hang Seng Mainland Banks Index (HSMBI)

 10 largest and most representative 

 HKEX-listed mainland banks stocks

 Index Level  2,344.87 (As at 29 December 2023)

 Index Volatility (30-Day Historical)  18.1

 Index Avg. Day High-Low Range  27.55 (December 2023)

 HSI Correlation (2023)  0.78

 HSCEI Correlation (2023)  0.791

 Contract Multiplier  HK$50

 Notional Value (1 Contract)  HK$0.12Mn (As at 29 December 2023)

 Avg. Quote Size  HK$0.59Mn (5 Contracts)

 Avg. Bid-Ask Trading Spread  N/A

 Liquidity Providers  N/A

Stamp Duty  N/A

Trading Fee  HK$2 / contract

SFC Levy  HK$0.54 / contract

Margin as of 28 Dec 2023  HK$5,930

Transaction Cost*

 Hang Seng Mainland Banks Index Futures

 Index Description

0.24%
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0.38%
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0.34%

0.35%

0.40%

0.74%

N/A
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HSMBI Futures
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CES120 Index Futures Performance
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Data Source: HKEX, HSIL, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference only

As at 29 December 2023

0.14%

0.16%

0.27%

N/A

X iShares A50 ETF (2823.HK)

CSOP FTSE A50 ETF (2822.HK)

ChinaAMC CSI300 ETF (3188.HK)

CES120 Futures

CES120 & Top Constituents’ 3-Month Performance

(Rebased to 100)

Futures contracts have relatively lower transaction costs CES120 Futures can be used to hedge A-share positions

5-Min Avg. Bid-Ask Spreads (29 December 2023)
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CES120 Index Tencent CCB

Ping An China Mobile

 CES120 Index

 80 A-Shares and 40 HK-listed Mainland

 China H-shares, P-chips, and red chips

 Index Level  4,911.20 (As at 29 December 2023)

 Index Volatility (30-Day Historical)  16.2

 Index Avg. Day High-Low Range  60.43 (December 2023)

 CSI300 Correlation (2023)  0.865

 FTSE A50 Correlation (2023)  0.871

 Contract Multiplier  HK$50

 Notional Value (1 Contract)  HK$0.25Mn (As at 29 December 2023)

 Average Quote Size  HK$1.23Mn (5 Contracts)

 Average Bid-Ask Trading Spread  N/A

 Liquidity Providers  N/A

Stamp Duty  N/A

Trading Fee  HK$5 / contract

SFC Levy  HK$0.54 / contract

Margin as of 28 Dec 2023  HK$12,910

Transaction Cost*

 CES120 Index Futures

 Index Description
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Data Source: HKEX

Item Hang Seng Index Futures
Hang Seng China Enterprises Index 

Futures
Hang Seng TECH Index Futures

Underlying Index Hang Seng Index Hang Seng China Enterprises Index Hang Seng TECH Index

HKATS Code HSI HHI HTI

Contract Multiplier HK$50 per index point

Minimum 

Fluctuation
One index point

Contract Months

Short-dated Futures: Spot, next three calendar month & next three calendar quarter 

months;

Long-dated Futures: The three months of Jun and Dec plus the next three months of Dec

Short-dated Futures: Spot, next three 

calendar month & next three calendar 

quarter months;

Long-dated Futures: The three months of 

Jun and Dec

Pre-Market 

Opening Period
8:45 am - 9:15 am & 12:30 pm - 1:00 pm

Trading Hours
9:15 am - 12:00 noon, 1:00 pm - 4:30 pm & 5:15 pm - 3:00 am

(Closed at 4:00 pm on the Last Trading Day)

Last Trading Day The second last trading day of the contract month

Final Settlement 

Price
Average quotations of the underlying index taken at five minute intervals during the Last Trading Day

Exchange Fee HK$10.00 HK$3.5 HK$5.00
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Data Source: HKEX

Item Hang Seng Index Options
Hang Seng China Enterprises 

Index Options
Hang Seng TECH Index Options

Underlying Index Hang Seng Index Hang Seng China Enterprises Index Hang Seng TECH Index

HKATS Code

Monthly contracts: HSI

Weekly contracts: “HSI” + Strike + Month + 

Year + “W” + Expiry Day

Monthly contracts: HHI

Weekly contracts: “HHI” + Strike + 

Month + Year + “W” + Expiry Day

HTI

Contract Multiplier HK$50 per index point

Minimum Fluctuation One index point

Contract Months / 

Contract Weeks

Monthly contracts

Short-dated Options: Spot, next three calendar months & next three calendar 

quarter months;

Long-dated Options: the next 3 months of Jun & Dec

and the following 3 Dec months

Weekly contracts

Spot Week and the next week, except where the Expiry Day of the Weekly Contract 

is the same as the Expiry Day of the Spot Month Contract

Monthly contracts

Short-dated Options: Spot, next three 

calendar months & next three 

calendar quarter months;

Long-dated Options: the next 3 months of

Jun & Dec

Exercise Style European Style

Option Premium Quoted in whole index points

Strike Price

Index points Strike interval Index points Strike interval

Short-dated Options (monthly and weekly contracts): Long-dated Options (monthly contracts only):

≥ 20,000 200 ≥ 20,000 400

≥ 5,000 and < 20,000 100 ≥ 5,000 and < 20,000 200

< 5,000 50 < 5,000 100

Trading Hours 9:15 am - 12:00 noon, 1:00 pm - 4:30 pm & 5:15 pm - 3:00 am (Closed at 4:00 pm on the Expiry Day)

Expiry Day
The second last trading day of the contract month (monthly contracts)

The last trading day of the contract week (weekly contracts)

Official Settlement 

Price
Average of quotations of the Index taken at five minute intervals during the Expiry Day

Exchange Fee HK$10.00 HK$3.50 HK$5.00
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Data Source: HKEX

Item
Hang Seng Index Futures 

Options

Hang Seng China Enterprises 

Index Futures Options

Hang Seng TECH Index Futures 

Options

Underlying Index Hang Seng Index Futures
Hang Seng China Enterprises Index 

Futures
Hang Seng TECH Index Futures

HKATS Code PHS PHH PTE

Contract Multiplier HK$50 per index point

Min. Fluctuation One index point

Contract Months

Short-dated Options: Spot, next three calendar months & next three 

calendar quarter months and

Long-dated Options: the next 3 months of June & December and the 

following 3 December months 

Short-dated Options: Spot, next three 

calendar months & next three calendar 

quarter months and

Long-dated Options: the next 3 months 

of June & December after Short-dated 

Options

Exercise Style European Style

Option Premium Quoted in whole index points

Strike Price

Index points Strike interval Index points Strike interval

Short-dated Options: Long-dated Options:

≥ 20,000 200 ≥ 20,000 400

≥ 5,000 and < 20,000 100 ≥ 5,000 and < 20,000 200

< 5,000 50 < 5,000 100

Trading Hours
9:15 am - 12:00 noon, 1:00 pm - 4:30 pm & 5:15 pm - 3:00 am

(Closed at 4:00 pm on the Expiry Day)

Expiry Day The third Friday of the contract month 

Settlement on 

Exercise
Physical delivery on Exercise.  All in-the-money options are automatically exercised upon expiry

Official Settlement 

Price

Average of quotations of the Index Futures Contract of the same contract month, 

taken at five second intervals from 3:55 p.m. – 4:00 p.m. on the Expiry Day of the Index Futures Options

Exchange Fee HK$10.00 HK$3.5 HK$5.0



Hang Seng TECH Index Futures and Options Access Codes
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Data Source: HKEX

Information Vendor Hang Seng TECH Index Futures Hang Seng TECH Index Options

AAStocks 221014 322400

ACTIV Financial HTI/<yy><m>.HF HTI/<yy><mm>/<strike><t>.HF

Bloomberg L.P. HCTA Index HSTECH Index OMON

Colt Technology HTImy HTI<Strikes>my

DB Power Online HTI HTI

DZH HTI

East Money 

Information

HTI

ESunny Information HTI HTI

ETNet HTI HTI

Hexin Flush HTI HTI

Infocast Ltd HTI HTI

N2N-AFE 870840 873201-7

QianLong 229

Refinitiv 0#HHTI 0#HTI*.HF

Shanghai Pobo HTI + Month Code

WebStock HTI HTI

Wind HTIF.HK HTIO.HK



MSCI China A 50 Connect Index Futures Access Codes
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Data Source: HKEX

Information Vendor MSCI China A 50 Connect Index Futures

AAStocks 221790

ACTIV Financial MCA/<yy><m>.HF

Bloomberg L.P. MCYA Index

Colt Technology MCAmy

East Money Information MCA

ESunny Information MCA

ETNet MCA

Infocast Ltd MCA

N2N-AFE 870939

Refinitiv 0#HMCA:

SIX Financial MCAmy

Wind MCAF.HK



MSCI Asia and Emerging Market Index Futures Access Codes
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Data Source: HKEX

Information 

Vendor

MSCI 

Australia NTR 

(USD) Index 

Futures

MSCI China A 50 

Connect (USD) 

Index Futures

MSCI China 

(USD) Index 

Futures

MSCI China NTR 

(USD) Index 

Futures

MSCI EM Asia 

ex China NTR 

(USD) Index 

Futures

MSCI EM Asia 

ex Korea NTR 

(USD) Index 

Futures

MSCI EM Asia 

NTR (USD) 

Index Futures

MSCI EM EMEA 

NTR (USD) 

Index Futures

MSCI EM ex 

China NTR 

(USD) Index 

Futures

Bloomberg HKCA Index MCYA Index CSIA Index CJEA Index HQOA Index HQRA Index HRSA Index HQTA Index HQDA Index

Refinitiv 0#HMAN: 0#HMCA: 0#HCHI: 0#HCHN: 0#HMAC: 0#HMAK: 0#HEAN: 0#HMEE: 0#HMXC:

WIND MANF.HK MCAF.HK EANF.HK

Information 

Vendor

MSCI EM ex 

Korea NTR 

(USD) Index 

Futures

MSCI EM 

LatAm NTR 

(USD) Index 

Futures

MSCI 

Emerging 

Markets (USD) 

Index Futures

MSCI 

Emerging 

Markets NTR 

(USD) Index 

Futures

MSCI Hong 

Kong NTR 

(USD) Index 

Futures

MSCI India 

(USD) Index 

Futures

MSCI India 

NTR (USD) 

Index Futures

MSCI 

Indonesia 

Index (USD) 

Futures

MSCI 

Indonesia NTR 

(USD) Index 

Futures

MSCI Japan

(JPY) Index 

Futures

Bloomberg HQIA Index HQYA Index HMPA Index HMOA Index HLCA Index HRTA Index HJDA Index HMLA Index HKBA Index HQAA Index

Refinitiv 0#HMXK: 0#HMEL: 0#HMEM: 0#HEMN: 0#HMHN: 0#HMDA: 0#HMIN: 0#HMID: 0#HMDN: 0#HMJP:

WIND MINF.HK MDNF.HK

Information 

Vendor

MSCI Japan 

NTR (JPY) 

Index Futures

MSCI Japan 

NTR (USD) 

Index Futures

MSCI Malaysia 

(USD) Index 

Futures

MSCI Malaysia 

NTR (USD) 

Index Futures

MSCI New 

Zealand NTR 

(USD) Index 

Futures

MSCI Pacific 

ex Japan NTR 

(USD) Index 

Futures

MSCI Pacific 

NTR (USD) 

Index Futures

MSCI 

Philippines 

(USD) Index 

Futures

MSCI 

Philippines 

NTR (USD) 

Index Futures

MSCI 

Singapore 

Free (SGD) 

Index Futures

Bloomberg HQBA Index HJCA Index HMYA Index HKEA Index HOPA Index HRPA Index HRBA Index HNSA Index HLEA Index HKOA Index

Refinitiv 0#HMJJ: 0#HMJU: 0#HMMY: 0#HMMN: 0#HMNZ: 0#HMPJ: 0#HMPC: 0#HMPH: 0#HMPN: 0#HMSG:

WIND MJUF.HK MMNF.HK

Information 

Vendor

MSCI 

Singapore 

Free NTR 

(USD) Index 

Futures

MSCI 

Singapore 

NTR (USD) 

Index Futures

MSCI Taiwan 

(USD) Index 

Futures

MSCI Taiwan 

25/50 (USD) 

Index Futures

MSCI Taiwan 

25/50 NTR 

(USD) Index 

Futures

MSCI Taiwan 

NTR (USD) 

Index Futures

MSCI Thailand 

(USD) Index 

Futures

MSCI Thailand 

NTR (USD) 

Index Futures

MSCI Vietnam 

(USD) Index 

Futures

MSCI Vietnam 

NTR (USD) 

Index Futures

Bloomberg HOBA Index HKPA Index HJAA Index HRCA Index HRDA Index HJBA Index HMTA Index HKDA Index HNTA Index HKSA Index

Refinitiv 0#HMGN: 0#HMSN: 0#HMTW: 0#HTWP: 0#HTWN: 0#HMWN: 0#HMTH: 0#HMTN: 0#HMVT: 0#HMVN:

WIND MTWF.HK MWNF.HK MTNF.HK



Weekly HSI and HSCEI Options Access Codes
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Data Source: HKEX

MSCI AxJ and MSCI AxJ Futures Access Codes

Information Vendor Weekly HSI Options Weekly HSCEI Options

AASTOCKS 322105 322125

Bloomberg HSI Index OMON HSCEI Index OMON

DB Power HSI HHI

ET Net Limited Menu "Futures/Options" > "Futures/Options Quotation (Short-term)“ > Access code: The series name

Infocast HSI HHI

MegaHub Limited HSI HHI

N2N-AFE 873101 873121

Refinitiv <0#HSIW*.HF> <0#HCEIW*.HF>

Tele-Trend File->Open->Options->HSI File->Open->Options->HHI

Hong Kong and International Information Vendors

Information Vendor MSCI AxJ Index MSCI AxJ Index Futures

AASTOCKS - 221495

Activ Financial - MXJ/<yy><m>.HF

Bloomberg M1ASJ Index MJSA Index CT

CQG - MXJ

DB Power - MXJ

East Money Information - MXJ

Factset - MXJE

ICE Data Services - F:MXJ

Infocast - MXJ

N2N-AFE - 870823

QPWeb - P11203

SIX Financial Information - MXJmy

Refinitiv .MIAX00000NUS 0#HMXJ:

Telequote Data - MXJ/<yy><m>.HF

Tele-Trend - MXJFC, MXJmyy

Hong Kong and International Information Vendors



Sector Index and Sector Index Futures Access Codes
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Data Source: HKEX

Information Vendor Mainland Banks 

Index

Mainland Banks 

Index Futures

AASTOCKS 221420

Activ Financial =0200700.HK MBI/16K.HF

AFE 837451 870809

Bloomberg HSMBI Index BMWA Index

DB Power MBI

ET Net MBN MBI

Infocast HSMBI MBI

QuotePower SEHK.HHSMBI P11223

Telequote MBImy

Refinitiv .HSMBI 0#HMBI:

Hong Kong and International Information Vendors

Mainland Information Vendors

Information Vendor Mainland 

Banks Index

Mainland Banks 

Index Futures

East Money HSMBI MBI

Hexin Flush Financial MBIC

Pobo Financial MBI+Month+Year

Qianlong 999905 209

Wind HSMBI MBIF+yymm+HK



CES120 Index and CES120 Index Futures Access Codes
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Data Source: HKEX

Information Vendor CES 120 Index CES 120 Index Futures

Bloomberg Finance L.P. CES120 CESA Index DES <GO>

Refinitiv .HKCES120 0#HCHH:

AAStocks.com Limited 110056 221360

AFE Solutions Ltd. 837505 870800

DB Power Online Limited CES120 CHH

ET Net Limited CEC CHH

Infocast Limited CE120 CHH

Interactive Data Group I:CES120 Fn:CHH\MYYDD

Marketprizm Hong Kong Limited CES120 CHHmy

SIX Financial Information Ltd. CES120 CHHmy

Telequote Data International Limited CES120 CHHmy

Hong Kong and International Information Vendors

Mainland Information Vendors

Information Vendor CES 120 Index CES 120 Index Futures

Hithink RoyalFlush Information Network Ltd CES120 CHHC

Shangahai DZH Limited CES120 CHH+Month Code+Year Code

Shanghai Gildata Services Co Ltd CES120 -

Shanghai Wind Information Co., Ltd CES120 CHHF+yymm+.HK

Zheng Zhou Esunny Information Technology Co, 

Ltd.
- CHH

Shanghai Wenhua Financial Information Ltd - CHHmy

Shanghai Qianlong Advanced Technology Co Ltd CES120 Page 209
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